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Presetationn Skills 

 

Preparing the Presentation 

Before developing a presentation on a given topic,  

 know the requirements, purpose and audience of the presentation  

 and then prepare an outline of the presentation. 

 

Know the Requirements 

Knowing the requirements of a presentation involves finding the answers 
for several relevant questions: 

a) How much time will you have to deliver the presentation? 

 This dictates how much you have to prepare and how detailed it should 
be.  

 The number of slides necessary for a 5-minute class presentation may 
differ considerably from what is necessary for a 30-minute project 
presentation. 
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b) Who and how many will be in the audience? 

This impacts  

 the formality of the presentation and  

 its context,  

 as well as the attire you may have to wear. 

 

 A thesis or dissertation presentation for a committee of faculty, or a 
project presentation for client at a company, may have a small 
audience and require formality in your delivery and attire (as 
appropriate for your discipline). 

 The context could involve evaluation of your presentation for a 
course grade or obtaining a project for your company. 

 Knowing the audience is also important for accommodating people 
with different abilities. 

 

c) Where will you deliver the presentation? 

This impacts the  

 design of presentation materials,  

 your delivery (whether you need a microphone or not) and the 
possibility to interact with the audience. 

 

 A small conference room (as opposed to a large classroom or an 
auditorium) may require developing different type of presentation 
materials. 

 A small conference room or classroom may allow you to interact easily 
with the audience, while a large auditorium where you deliver the 
presentation from the stage may not allow you that flexibility. 
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d) What type of technologies will be available to deliver the 
presentation? 

This impacts  

 the selection of technologies to match what will be available at the 
presentation location. 

 

 The delivery technologies can include presentation software and data 
projector, document camera, flip charts, microphone, web browsers, 
etc. 

 If you design your presentation using an online presentation tool, and 
plan to deliver the presentation using the same, it is critical to make 
sure that online presentation tool will be available at the delivery 
location, or you can bring your own. 

 

e) Will you deliver the presentation alone or as part of a panel or a 
team? 

This impacts  

 what you prepare and  

 how you will have to deliver it. 

 

 If you have to deliver the presentation by yourself, you will have 
considerable flexibility on how you can design and deliver your 
presentation. 

 If you have to present as part of a panel or a team, then you may have 
to coordinate with other presenters, to align your portion appropriately 
with theirs and not duplicate material. 
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f) Do you have to prepare handouts of your presentation to 
distribute to the audience? 

This impacts  

 the design of your presentation materials and  

 the cost of making copies of the presentation. 

 

 Some presentation materials may come across well on a large screen 
but not on paper. 

 Distributing copies of your presentation will require you to know in 
advance how many copies to make, and any to make in large fonts for 
those with visual impairments. 

 

g) What alternatives do you have if there are unexpected changes 
at the last minute to any of the previous items? 

This helps you to  

 develop Plan B solutions in case there are unexpected changes. 

 Planning simple alternatives to handle unavailability of particular 
delivery technologies in the presentation location or change in 
presentation duration can reduce stress and help you deliver your 
presentation effectively. 

 Saving presentation materials in different formats and media will help 
to adapt to any unexpected changes at the last minute. 
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Know the Purpose 

Learn about the purpose of your presentation from your course instructor or 
the organizer of your presentation. 

The purpose of a presentation can be (and are not limited) to: 

a) Inform an audience, as in a formal thesis or project presentation 
Informative Presentation 

b) Persuade (motivate or encourage) an audience, as in selling a 
proposal for service to a client or convincing an interviewer 
Persuasive Presentation 

c) Entertain an audience, as in presenting at a reception 
Entertaining Presentation 

d) Speak on a special occasion, such as honoring a colleague 
Honoring Presentation 

e) Educate an audience, as in teaching or training a group of people 

 

Knowing the purpose of the presentation will help you design, develop, and 
deliver the presentation for the intended purpose. 

For example, a brief technical presentation for informing an audience may 
not leave time for very many interactions with the audience, including 
questions and answers (Q&A) at the end. 

However, a technical presentation as part of a thesis or dissertation defense 
will involve considerable Q&A by the faculty committee and the audience. 

Presenting for the purpose of educating or training an audience may require 
considerable interaction and Q&A during the presentations. 

Presenting for the purpose of entertaining an audience may not be very 
formal, whereas honoring someone may be formal, and both may not involve 
Q&A at the end. 



Presentation Skills   Dr. Intisar A.M. Al Sayed 

7 
 

Knowing the purpose of the presentation can also help in arranging the room 
layout and audience seating (if that flexibility is available), so you can interact 
easily with the audience appropriately. 

 

Know the Audience 

 It is important to know your audience demographics before you prepare 
your presentation. (Presentation Level Appropriate or Inappropriate) 

 

 Knowing who they are (faculty, students, etc.), their familiarity with the 
topic, and their role (gain information, evaluate your learning, etc.) in 
attending your presentation, will help you organize your thoughts 
appropriately. 

 

 Presenting a topic to a specific audience requires careful preparation 
so the presentation will make sense to them and fulfill their needs.  

 Some audience demographics include age, gender, faculty or students 
and educational background.  

 Presenting to a group of your peers will require you to present the topic 
with authority, but on their level of understanding and with the ability to 
motivate them to ask questions.  

 Presenting to a faculty audience will also require you to present the 
topic with authority, but you may need to prepare for more substantial 
questions and remarks. 
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Prepare an Outline 

 Once you know the requirements and the purpose of the presentation, 
the next step is to prepare an outline.  

 

 Preparing an outline will give you a roadmap or a sense of direction for 
developing the presentation for the required purpose. 

 

 Before you develop an outline, ask yourself what you would want your 
audience to know in the time you have to present it. The outline should 
consist of the major headings or topics of your presentation. 

 

 The outline should have a beginning, middle and an end so that the 
audience can follow your ideas logically from the beginning to the end. 
You can then set each major topic or heading into appropriate points. 

 

The type of outline and the list of headings or topics may depend on the 
nature of the discipline and the purpose of a presentation. 

For example, the outline of a technical presentation for informing an 
audience can consist of headings such as: 

 Problem statement 
 Objectives and scope 
 Literature review 
 Methodology 
 Experimentation 
 Analysis 
 Conclusions 
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Similarly, the outline of XYZ corporation's (your employer) proposal 
presentation to a client ABC Co. for obtaining a project can consist of 
headings such as: 

 Welcome and introductions 
 Needs and trends 
 XYZ corporation 
 XYZ’s products and services 
 Major clients of XYZ 
 How XYZ can serve the needs of ABC 
 Possible opportunities 
 Contact information 
 Questions and answers 

An example of an outline for a non-technical presentation in the humanities 
or other disciplines could include the following: 

1. Introduction 
1. Purpose, thesis, preview 

2. Body of Presentation 
1. First (second, third) point(s), supporting evidence of thesis 
2. Possible objections analyzed and or refuted 
3. Source of information 
4. Transition to conclusion 

3. Conclusion 
1. Restate thesis 
2. Statement of possible actions, next steps 
3. Memory and attention-reinforcing strategies (quote, anecdote, 

etc.) 
4. Discussion of limitations, missing elements 
5. Closing or summary statement 

Depending on the allotted duration of your presentation, you can then plan 
on how much time to spend on each topic, and develop the presentation 
materials accordingly. 

The outline will depend on the content of your presentation and the outline 
need not dictate how the presentation will be delivered. 

One can develop an outline or a framework for a presentation but organize 
the content in a non-sequential manner for delivery. This is especially suited 
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for when the outline is in the form of a pictorial framework where each part 
can be presented non-sequentially. 

Once you have developed the outline of your presentation, the next step is 
to organize the content.  

 

Similarly, the outline of XYZ corporation's (your employer) proposal 
presentation to a client ABC Co. for obtaining a project can consist of 
headings such as: 

 Welcome and introductions 
 Needs and trends 
 XYZ corporation 
 XYZ’s products and services 
 Major clients of XYZ 
 How XYZ can serve the needs of ABC 
 Possible opportunities 
 Contact information 
 Questions and answers 

 

An example of an outline for a non-technical presentation in the humanities 
or other disciplines could include the following: 

1. Introduction 
1. Purpose, thesis, preview 

2. Body of Presentation 
1. First (second, third) point(s), supporting evidence of thesis 
2. Possible objections analyzed and or refuted 
3. Source of information 
4. Transition to conclusion 

3. Conclusion 
1. Restate thesis 
2. Statement of possible actions, next steps 
3. Memory and attention-reinforcing strategies (quote, anecdote, 

etc.) 
4. Discussion of limitations, missing elements 
5. Closing or summary statement 
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 Depending on the allotted duration of your presentation, you can then 
plan on how much time to spend on each topic, and develop the 
presentation materials accordingly. 

 The outline will depend on the content of your presentation and the 
outline need not command how the presentation will be delivered. 

 One can develop an outline or a framework for a presentation but 
organize the content in a non-sequential manner for delivery.  

 Once you have developed the outline of your presentation, the next 
step is to organize the content. 

  

Organizing the Presentation 

 Organize the content of your presentation in a logical sequence based 
on the outline you prepared.  

 

 No matter how you decide to organize your presentation, keep the 
audience engaged to better help them remember the content.  

 

 You can do this by asking them questions or having them share 
experiences related to the topic. 

 

a) The Beginning of the Presentation 

 The beginning of your presentation sets the tone for the rest of the talk, 
so it is important to impress your audience with your approach, style 
and topic.  

 Begin the presentation with something that attracts the audience’s 
attention, but keep it relevant to the topic and avoid jokes or irrelevant 
comments that could be misunderstood by the audience, especially if 
you are not familiar with the audience. 

 



Presentation Skills   Dr. Intisar A.M. Al Sayed 

12 
 

You can begin with  

 an important statistic relevant to the topic, or  
 a quote, or  
 ask a question  

that interests the audience in the topic.  

 

For example,  

if the focus of your presentation is about environmental pollution by 
household activities, a simple question to interest the audience in your 
presentation could be "Does anyone know how many drops of drinking water 
are polluted by one drop of motor oil?"  

If anyone in the audience knows the correct answer, acknowledge that 
individual and ask how many of them knew that as well. Otherwise, give the 
answer, and begin your presentation. 

 

b) The Body of the Presentation 

 Begin planning the body of your presentation first.  

 Once you have developed this part of the presentation, the beginning 
and end will fall into place. 

 You can order the main points of each section of your presentation as 
outlined in one of several ways depending on the nature of the 
presentation.  

 

 Some possible orders of points include the following, though there can 
be others, depending on the topic and/or discipline: 

1) Spatial order – suitable for describing a layout or a process, from the 
beginning or entry point, to the end or exit. 

2) Chronological order – suitable for discussing literature review by 
years, or for describing the steps for doing something. 
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3) Causal order – suitable for explaining causes and their effects. For 
example, how lack of sleep impacts worker productivity and safety. 

4) Topical order – suitable for presenting on different topics in a field 
such as different types of problem-solving techniques. 

5) Problem–Solution order – suitable for describing a particular 
problem and how it can be solved. 

Choose the order suitable for covering the main points of your presentation 
for the particular section of the outline. 

c) The End of the Presentation 

End the presentation by reiterating the purpose of the presentation, 
summarizing the major points, and concluding with a quote, remark or fact 
that the audience will remember. 
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Designing Effective Presentation Materials 

 

 Visual aids can enhance a presentation by illustrating complex 
content, sometimes better than actually talking about it.  

 Depending on the type of presentation and delivery technologies 
available, you will have to select appropriate presentation tools or 
audio-visual aids to deliver your presentation. 

 

 The audio-visual aids in general can be presentation slides, audio 
(music, sounds, narration), video clips, real or scaled objects, etc. 

 The audio-visuals you select must be suitable for the size of the 
audience, room layout, lighting, sound system, etc.  

 For example, in a large auditorium with an audience of several hundred 
people, showing a video clip with audio may not work well if there is no 
sound system. 

 You should have a good idea about the presentation set up from the 
preparation stage to select the appropriate audio-visual aids for 
delivery. 

Did You Know? 

People remember 65% of information from a visual and oral presentation, 
35% from a visual presentation, and 10% from an oral-only presentation. 
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Audio-Visual Aid Design Principles 

The following are general principles to remember in designing audio-visual aids: 

1. Use Simple or No Background in Presentation Materials 

Keep your presentation materials simple. Do not use complicated background 
designs that can distract from the content. 

2. Use Colors That Provide Adequate Contrast and Make it Easier 
to Read 

For example, use dark letters on a light background; and do not use light letters 
on a light background or dark letters on a dark background. It is better to use black 
or dark blue letters on a white background. 

If colors used have meaning, remember that people with color blindness or visual 
impairment may not recognize the meaning. 

 

3. Use Adequate Font Size That Allows Easy Reading of Text from 
the Last Row of the Room 

Prepare a sample presentation screen, and see if you are able to view it from the 
last row of the room (if you know the location and have advance access to it). 
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4. Use Distinct Font Sizes for Titles and Section Headings 

Use distinct font sizes for titles or section headings compared to points covered in 
those sections, and make sure they are consistent throughout. Turn off any "auto 
size" feature in presentation software to help with this. 

 

5. Limit Bullet Points to Four to Five Points per Slide, and Not More 
Than Seven Bullet Points 

 

 

Limit each point to no more than two, or at most three, lines of text 

Do not have whole paragraphs of text on the screen as the audience may not be 
able to read it. 

 

Note that bullet points need not be complete sentences (unless it is a quote or a 
definition) and can be partial sentences or phrases. 
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6. Ensure Images Are Legible (Clear) from the Last Row of the 
Room and Convey the Intended Content 

If you have a large figure, show a high-level outline of the figure and then focus on 
the specific details of the figure on the following slide. 

 

 

7. Ensure Animations or Transitions Don't Distract 

When using animations or transitions in presentation materials, make sure they do 
not distract from the content and do not have a jarring effect. 

8. Ensure Chart Scales Don't Mislead 

If you use graphs or charts in your presentation materials, make sure axis scales do 
not mislead the audience on the trends.  

 

9. Show Video Clips at Easily Viewable Size 

If you include video clips, make sure the size of the clip (¼, ½ or full size) on the 
screen is viewable for the audience. 

10. Do Not Use Offensive (aggressive) or Stereotypical Visuals 

If you use cartoons or animations or clip arts, make sure they are not offensive 
(violent) and do not stereotype people. 
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11. Play Audio at Easily Heard Levels 

If you use audio clips, the sound system in the room should be adequate for the 
audience to hear. 

12. Share Real or Scaled Objects at Easily Viewed Sizes 

If you show real or scaled objects during your presentation, make sure they are 
viewable from the last row or use a document camera to display it. 

13. Test Audio-Visual Aids in Advance 

Test the audio-visual aids, especially if you use special plug-ins or players or 
different versions of software for display. 

14. Design Your Audio-Visuals So All Members Can 
Experience Them 

If you will have audience members with particular disabilities, then you will have to 
design the audio-visuals accordingly. Common disabilities may include color-
blindness, visual impairment, hearing impairment, etc. 

 

15. Correct and Spell-Check 

Corrected and spell-check presentation materials for grammar and spelling errors. 
Even minor errors will be glaring on a large screen! 

 

16. When Using the Board or Flip Charts, Write Large Text and 
in a Logical Flow 

If you plan to use the board or flip charts, learn to write in big letters or draw 
appropriately-sized figures so that the audience can view the information easily. 

When writing on the board or flip charts, write from left to write and from top to 
bottom, so the audience can follow the logical flow of information. 

 



Presentation Skills   Dr. Intisar A.M. Al Sayed 

19 
 

17. Cite Sources Properly 

If you include content from external sources in your presentation, include in-text 
citations where necessary and list the corresponding references at the end of the 
presentation materials. 

 

18. Acknowledge Your Contributors 

Acknowledge those who helped you with the presentation, including your team 
members, at the end of the presentation materials. 

19. Remember Your Visuals Are to Enhance and Not Distract 

Most importantly, design materials to enhance your presentation and help you 
deliver the content effectively, not to distract from it!  

 

 

 

Delivering the Presentation 
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Once you have prepared the presentation well, here are some simple suggestions 
to consider in delivering the presentation effectively. 

1. Dress Appropriately 

o Dress appropriately for the presentation, based on the context, disciplinary 
protocols, formality of the occasion and the type of audience (faculty, 
students, clients, etc.).  

o Do not wear inappropriate clothing, jewelry, hats or footwear that distract. 

2. Arrive Early 

Arrive early for the presentation, and do not arrive just in time or late. 

3. Meet the Moderator 

If there is a presentation moderator who will introduce you, meet that person well 
in advance of the presentation so they know you are in the room on time and that 
you will be ready. 

4. Decide How to Handle Audience Questions 

Decide how you will handle questions during the presentation, and either request 
the audience to wait until you are finished with your presentation or make sure you 
will have time to answer the question in the middle of your presentation. 

5. Have a Plan if the Technology Fails 

Similarly, decide how you will continue your presentation if the presentation 
technology fails or freezes in the middle of your presentation. 

6. Greet the Audience 

If you have some free time before the presentation starts,  

o walk up to some members of the audience, introduce yourself and thank 
them for being there.  

o This may put you at ease during the presentation. 

7. Load Your Visuals Before Your Allotted Presentation Time 
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If you plan to use presentation tools, load your presentation or connect your 
presentation device to the projector before you are asked to present so you do not 
use up your presentation time to load your files and make the audience wait. 

8. Smile 

Be pleasant and smile when you stand in front of an audience so it makes the 
audience feel comfortable listening to you. 

9. Don't Eat or Chew Gum 

o Do not chew gum or eat during your presentation.  
o You may drink water or other allowed drinks during the presentation. 

10. Take a Deep Breath 

Before you begin to speak, take a few deep breaths and calm yourself. 

11. Speak Clearly 

Speak slowly and clearly, and do not rush through sentences, as some do when 
they get nervous. 

12. Speak at an Even Pace 

o Pay attention to the pace (speed) in which you speak,  
o to avoid your pace of delivery being either too fast or too slow for the 

audience to follow. 

13. Change the Inflection of Your Voice to Gain Audience Attention or to 
Emphasize Content 

o If you are trying to make a point about a particular idea, pronounce the 
words clearly and distinctly.  

o At this point, you can slow down and raise the volume of your voice to clearly 
express what you have to say.  

o Speak with authority (ability), confidence and enthusiasm (interest). 

14. Use Appropriate Gestures 
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Use appropriate gestures (signs or motions) to emphasize appropriate points, and 
do not make wild gestures or pace back and forth in front of the screen in a 
distracting manner. 

15. Make Proper Eye Contact 

Make proper eye contact: that is,  

o look at the audience from one side of the room to the other side, and from 
the front row to the last row.  

o Do not look down the whole time, and do not focus on just one side of the 
room or just the front row of the audience. 

16. Stand Beside the Screen 

If you plan to use projected visuals on a screen, stand to one side of the screen. 
Ideally, you should be facing your audience at all times and just glance at the screen 
to look at cues from the slides. 

17. Do Not Talk to the Screen or Board 

o Do not talk to the screen or the presentation device; look at the audience 
and talk.  

o It is alright to look at the screen occasionally and point to something 
important on the screen as you present. 

18. Do Not Read Line-by-Line 

Do not read presentation materials line-by-line unless there is someone in the 
audience who is visually-impaired and cannot see the slide, or if it is a quote that 
you have to read exact to emphasize. 

19. If You Get Stuck, Look at Your Notes 

If you get stuck on a point and do not know what to say, feel free to look at your 
notes to continue. 

20. Use the Microphone Effectively 
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If you are presenting in a large room where a handheld microphone is needed, hold 
the microphone near your mouth and speak directly into it. 

21. Do Not Curse or Use Inappropriate Language 

Do not use inappropriate language 

o if you forget a point during the presentation  
o or if the presentation technology fails. 

22. Be Considerate of Your Team 

If you are part of a team and giving a group presentation,  

o be considerate to other team members by not using up their time or 
dominating the presentation.  

o Smoothly transition from one presenter to another. 

23. Do Not Conclude Abruptly 

o Do not conclude the presentation abruptly by saying "This is it" or "I'm 
done."  

o Conclude properly by summarizing the topic and thanking the audience for 
listening. 

24. Be Considerate of the Next Presenter 

After your presentation and the question and answer part are over, remove your 
presentation materials from the desk or the podium, and close any open 
presentation software so the next presenter can get ready quickly. 

25. Thank Your Moderator 

Remember to thank your moderator (if there is one) and the audience, and if you 
were part of a panel presentation, make sure to thank the panel members. 

26. Participate in the Audience 

If there are other presentations scheduled after yours, do not leave the room, but 
stay and listen to their presentations. 
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Handling Questions and Answers 

At the end of your presentation, if it is appropriate for the type of presentation, 
solicit questions from the audience. 

 

Responding to Audience Questions 

When someone is asking a question,  

o make eye contact with that person,  
o listen positively, and  
o acknowledge by saying "thank you for that question," or say "that is an 

excellent question" or "that is an important question". 
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 If the audience is in a large room and cannot hear each other's questions, 
repeat the question loudly for everyone to hear, before answering it. 

 If you know the answer to the question, respond appropriately and briefly so 
you can take more questions and not spend too much time on one question. 

 If the question is not relevant to the presentation, say something like, "I am 
really sorry that question is outside the scope of this presentation, but I will 
be happy to stay after the presentation and discuss it with you." 

 If time is running out for answering all of the questions, say, "I am sorry. I am 
running out of time, but I will take one last question, and then I will be 
available at the end to answer any remaining questions." 

 If you do not know the answer to a question say, "That is an interesting 
question, and I will have to get back to you later on that" or ask the audience 
"Can someone help me with this?" or be kind and acknowledge you do not 
know the answer at that time. 

 If an audience member criticizes or attacks what you had covered in your 
presentation, do not attack back, but separate the valid criticism from the 
personal attack, and respond to the criticism appropriately. 

 

Asking Good Questions 

If you are in the audience, know also how to ask good questions to indicate that 
you are following the presentation.  

You can ask some general questions about any topic, and you may be interested 
about some things presented. 

 What were the most challenging aspects, or what surprised you the most, 
in conducting this project? 

 Why did you choose this particular methodology or argument instead of 
another one? 

 How did you collect the data? Were there any problems in collecting data? 
What was the sample size? 

 How did you validate your work? Did you validate with a real problem or 
situation? 

 What are some of the limitations of your work? 
 What recommendations do you have for further exploration in this project? 
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Learning to ask good questions at the end of a presentation demonstrates your 
active participation. 

 

Presentation Preparation Checklist 

Logistics 

 Time available for the presentation 
 Type of audience (faculty, students, client, etc.) 
 Type of attire to wear 
 Impact of the presentation (e.g. evaluated for a grade) 
 Location of the presentation 
 Delivery technologies available for the presentation 
 Present alone, or as part of a team or panel 
 Prepare handouts to distribute to audience members or not 
 Alternatives, in case some of the above change at the last minute 

Preparation and Design 

 Purpose of the presentation – inform, persuade (encourage), 
entertain, honor, educate, etc. 

 Presentation has an outline 
 Presentation has a beginning, middle and end 
 Opening statement attracts audience's attention 
 Main points of sections have an order – chronological, causal, spatial, 

topical, problem-solution, etc. 
 Type of audio-visuals to use – slides, audio, video clips, real or 

scaled objects, etc. 
 Background of slides is simple and not distracting 
 Font size (headings at least 28 pts and bullets at least 24 pts) – large 

enough to read from the last row of the room 
 Style of titles of slides are distinguishable from bullet points 
 Each slide has no more than 5 to 7 bullet points 
 Each bullet point is not more than 2 to 3 lines, and are phrases but 

not complete sentences (unless it is a quote or a definition) 
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 Titles and bullet points are consistent in font size throughout the 
presentation 

 Color contrast between background and bullet points is appropriate 
 Slides do not have inappropriate or unnecessary graphics or clip art 
 Presentation material has been proof-read and spell-checked 

thoroughly 
 Content (text, quotes, figures, tables) from external sources include 

in-text citations and corresponding references at the end 
 Sound system is adequate to listen to the video or audio clips, if any, 

included in the presentation 
 Screen size and resolution are adequate for viewing video clips 
 Presentation has been rehearsed, and timing is adequate for the 

allotted duration 
 Coordinated with other presenters, if it is a team or panel 

presentation 

Delivery 

 Any planned interactions with the audience have been rehearsed 
 The pace of delivery is consistent for all the sections of the 

presentation 
 There are no unnecessary fillers or sentence starters in the delivery 
 Delivery technologies have been checked and work properly 
 Gestures, eye contact, and body language are appropriate for the 

presentation 
 Prepared responses for anticipated questions are appropriate 
 Prepared conclusion ends the presentation appropriately, and does 

not end it abruptly 
 Attire chosen to wear for the presentation is appropriate for the 

presentation context 
 Any demonstration of software has been verified in advance to make 

sure it works properly 
 Handouts, if any, are readable as hardcopy of presentation slides 
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What is PowerPoint?  https://support.microsoft.com/en-us/office/ 

With PowerPoint on your PC, Mac, or mobile device, you can: Create presentations 
from scratch or a template. Add text, images, art, and videos. 

Create a presentation in PowerPoint 

Create a presentation 

1. Open PowerPoint. 
2. In the left pane, select New. 
3. Select an option: 

 To create a presentation from scratch, select Blank Presentation. 
 To use a prepared design, select one of the templates. 
 To see tips for using PowerPoint, select Take a Tour, and then 

select Create, . 

 

 

https://support.microsoft.com/en-us/office/
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Add a slide 

1. In the thumbnails on the left pane, select the slide you want your new slide to 
follow. 

2. In the Home tab, in the Slides section, select New Slide. 
3. In the Slides section, select Layout, and then select the layout you want from 

the menu. 

 

Add and format text 

1. Place the cursor inside a text box, and then type something. 
2. Select the text, and then select one or more options from the Font section of 

the Home tab, such as Font, Increase Font Size, Decrease Font 
Size, Bold, Italic, Underline, etc. 

3. To create bulleted or numbered lists, select the text, and then 
select Bullets or Numbering. 
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Add a picture, shape, and more 

1. Go to the Insert tab. 
2. To add a picture: 

 In the Images section, select Pictures. 
 In the Insert Picture From menu, select the source you want. 
 Browse for the picture you want, select it, and then select Insert. 

3. To add illustrations: 
 In the Illustrations section, select Shapes, Icons, 3D Models, SmartArt, 

or Chart. 
 In the dialog box that opens when you click one of the illustration types, 

select the item you want and follow the prompts to insert it. 

 



Presentation Skills   Dr. Intisar A.M. Al Sayed 

31 
 

Save in PowerPoint 

Save your presentation to OneDrive 

When you save your files to the cloud, you can share and collaborate with 

others, and get to your files from anywhere - on your computer, tablet, or 

phone. 

1. Select File > Save As. 

2. Select OneDrive. 

Save personal files to OneDrive - Personal, and work files to your 

company OneDrive. You can also save to another location, like your 

device. 

 

Offline 

When you're online, AutoSave is always on and saves your changes as you 

work. If at any time you lose your Internet connection or turn it off, any 

pending changes will sync as soon as you’re back online. 
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Design in PowerPoint 

Themes 

1. Select the Design tab. 
2. Select one of the Themes. 
3. Select one of the Variants. 

 

Use PowerPoint Designer 

1. Insert one or more pictures, a list of items, or a list of dates. 
2. The Designer panel will open. Select the design you want. 

You can also bring up Designer by selecting a picture, and then 
selecting Design > Designer. 
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Transitions 

To add a special effect, to transition from one slide to another: 

1. Select the slide you want to add a transition to. 
2. On the Transitions tab, select the effect you want. 
3. Select Effect Options to change how the transition happens: From 

Right, From Left, ... 

To undo a transition, select None. 

 

Animations 

To animate text or objects on a slide: 

1. Select the text or object you want to animate. 
2. On the Animations tab, select Add Animation, and select the animation you 

want from the drop-down. 

To animate one line of text at a time, select one line of text, select an 
animation, select the next line of text, select an animation, ... 
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3. For Start, select When Clicked, With Previous, or After Previous. 

You can also select the Duration or Delay. 

To learn more, see Animate text or objects. 

 

Share and collaborate in PowerPoint 

Share your presentation 

1. On the ribbon, select Share. 
 
If your presentation isn't already saved to OneDrive, you'll be prompted to 
save it there. 

2. In the Send Link dialog box, do the following: 
a. Enter the names or email addresses of the people you want to share with. 
b. Select the drop-down to change permissions, if you want. Allow editing is 

checked by default. To change permission to view only, uncheck this box and 
select Apply. 

3. Include a message if you'd like and select Send. 

You can also select Get a link to create a link that you can copy into an email. 

https://support.microsoft.com/en-us/office/animate-text-or-objects-305a1c94-83b1-4778-8df5-fcf7a9b7b7c6
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Co-author a presentation 

After you share your file, you can work together at the same time. 

 Under Share, see who is also working in the file. 
 Colored flags show where each person is editing. 
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Comments in presentations 

1. Select Review > Comment or @ Mention. Or select New if 
the Comments pane is open. 

2. In the Comments pane, type your comment in the box, @mention a 
collaborator if you like, and press Enter. 

3. Select Reply and type your response. 
4. Select See more comments to go between comments and slides. 
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Give a presentation in PowerPoint 

Start a presentation 

 On the Slide Show tab select From Beginning. Now, if you are working with 
PowerPoint on a single monitor and you want to display Presenter view, 
in Slide Show view, on the control bar at the bottom left select the three dots, 
and then Show Presenter View. 

 To move to the previous or next slide, select Previous or Next. 
 To view all the slides in your presentation, select See all slides. 

 

Notes 

During your presentation, the speaker notes are visible on your monitor, but 
aren't visible to the audience. 

 The Notes pane is a box that appears below each slide. Tap it to add notes. 
 If you don’t see the Notes pane or it is completely minimized, click Notes on 

the task bar across the bottom of the PowerPoint window 
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Subtitles 

You can choose which language the caption/subtitle text should be shown to your 
audience. This feature requires Windows 10 and an up-to-date version of 
PowerPoint. 

1. Select Slide Show > Subtitle Settings. 
2. Set your Spoken Language. 
3. Select Subtitle Language to see which languages PowerPoint can display on-

screen as captions or subtitles, and select the one you want. 
4. In the Subtitle Settings menu, set the desired position of the captions or 

subtitles. 
5. More appearance settings are available by selecting Subtitle Settings > More 

Settings (Windows). 



Presentation Skills   Dr. Intisar A.M. Al Sayed 

39 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

References:  

https://www.niu.edu/presentations/prepare/index.shtml 

https://support.microsoft.com/en-us/office/ 

 

https://www.niu.edu/presentations/prepare/index.shtml
https://support.microsoft.com/en-us/office/

